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Copyright 

While every attempt has been made to ensure that the information in this document is 
accurate and complete, some typographical errors or technical inaccuracies may exist. 
Merck Serono SA does not accept responsibility for any kind of loss resulting from the use 
of information contained in this document. 

This page shows the publication date. The information contained in this document is 
subject to change without notice. Any improvements or changes to either the product or 
the document will be documented in subsequent editions. 

This software/documentation contains proprietary information of Merck Serono SA. All 
rights are reserved. Reverse engineering of this software is prohibited. No part of this 
software/documentation may be copied, photocopied, reproduced, stored in a retrieval 
system, transmitted in any form or by any means, or translated into another language 
without the prior written consent of Merck Serono SA 

Copyright © 1999-2012 Merck Serono SA - Geneva, 9 chemin des Mines, 1202 Geneva, 
Switzerland, a branch of Merck Serono SA, Switzerland, an affiliate of Merck KGaA, 
Darmstadt, Germany. 

Merck Serono SA, the Merck Serono logo, iMed, and Rebif are trademarks or registered 
trademarks of Merck Serono SA in Switzerland and/or in other countries. All other names 
are trademarks or registered trademarks of their respective companies. 

 

By using this software you are agreeing to be bound by the terms of the Software License 
Agreement. If you do not agree to the terms of this License, do not use this software. 
Please read through the Software License Agreement carefully before using iMed. 

 

Disclaimer of Warranties 

The iMed Software is provided to User by Merck Serono SA, Switzerland, (“Merck 
Serono”) and any third parties retained by Merck Serono, “As Is” without warranty 
of any kind, whether express or implied, written or oral, including any warranty of 
merchantability or fitness for a particular purpose, and any warranties arising out of 
course of dealing.  

User expressly acknowledges and agrees that user is solely responsible for use of the 
software in general. User assumes entire risk as to the installation, accuracy and use of 
the software, including obtention of any authorizations and consents required by User for 
installation and use of the software. In particular Merck Serono does not warrant that 
installation and operation of the software will be uninterrupted or error-free or that defects 
in software will be corrected. 

User shall assume the entire cost of all necessary equipment (hardware, third party 
software, internet access, etc.) for the installation and use of the software, including any 
servicing or repair arising out of or in connection with such installation or use.  

In addition all terms and conditions of the Software License Agreement apply. 
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1 Welcome to iMed 

1.1 What is iMed? 

iMed is a powerful electronic system for storing clinical data about patients with Multiple 
Sclerosis. It allows you to manage all the important information about your patients, 
including their medical history, neurological status, relapses, treatments, neurological 
rating scores on various scales, and results on magnetic resonance imaging (MRI), 
cerebrospinal fluid (CSF) and evoked-potentials tests. 

iMed has an intuitive user interface, which allows you to become immediately productive. 
In particular, iMed provides interactive graphical charts, which allows you to quickly 
analyze data on multiple patients, or to drill-down to the details on a specific patient. 

iMed also provides secure multiple-user support, allowing you to share a single patient 
database between multiple users over your network. It even enables you to share and 
benchmark anonymous patient data using the MSBase International MS Patient Registry 
(www.msbase.org). 

1.2 What’s New in iMed? 

If you have been using a previous version of iMed, you will find a number of new features 
in iMed, which make the application even more powerful and easy to use. 

1.2.1 New in iMed 6 

• Refreshed design: iMed displays now a refreshed interface. The new look and feel 
of the program makes it even more easy and fun to use.  

• Neurostatus: You can now choose to report the FS scores and Ambulation according 
to the Neurostatus definitions. Neurostatus provides a standardised methodology for 
the scoring of Kurtzke’s Functional Systems and Expanded Disability Status Scale in 
MS. 

• Czech and Greek languages: The new iMed includes two new languages, Czech 
and Greek, which can be selected individually from the Preference panel. 

• Communication with MSBase: The new iMed makes it possible to upload data to 
your MSBase account in just one click. Also, you will immediately identify your list of 
patients enrolled in MSBase sub-studies.  

1.2.2 New in iMed 5.5 

• Safety tab: A new Safety tab is now available in the Visit page to view or edit any 
changes in the medical condition of the patient. In particular, malignancies and 
infections can be followed-up more easily. 

1.2.3 New in iMed 5.4 

• MusiQoL: Starting from version 5.4, iMed includes the MusiQoL (Multiple Sclerosis 
International quality of life questionnaire) instrument in any form of MS. The MusiQoL 
questionnaire is a self-administered multidimensional HRQoL indicator, and is the 
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only globally specific MS HRQoL tool constructed from the MS patients' perspective, 
and the only MS specific questionnaire not adapted from a generic tool. 

• Dutch and Russian languages: With the addition of the Dutch and Russian 
languages, the iMed interface is now available in 10 languages. 

1.2.4 New in iMed 5.3 

• Connection with RebiSmart™ device: The injection log stored in the RebiSmart 
device can be transferred to iMed. The treatment compliance is calculated and 
displayed on the patient summary graph. 

1.2.5 New in iMed 5.0 

• New look and feel: The new user interface of iMed sports a refreshed look while 
keeping all its usual features. The new iMed sidebar allows instant access to your 
most frequently used features and queries. 

• Directory of Care Professionals: iMed can store contact information for the care 
professionals involved in the care of the patients. Contacts can also be imported from 
the standard vCard format. 

• Calendar: You can now manage a calendar of events directly from iMed. Calendars 
can be exported to the standard vCal format for integration with other information 
systems. 

• Improved search: Frequently used queries are available with one-click access from 
the sidebar. Searches can be performed on all the fields, as well as on your 
flexifields. 

• Improved MRI screen: The iMed user interface for storing and viewing MRIs has 
been revamped. 

• Improved reporting: you can now save iMed-generated letters and reports in Word 
format as well as PDF. 

1.2.6 New in iMed 4.5 

• Flexifields: Fields missing in iMed? You can extend iMed by defining your personal 
fields to store additional structured information about your patients. 

• Reporting Module: Create your own templates of letters and reports with your clinic 
details and logo (e.g. referral letters). iMed can then generate customized printouts 
integrating patient-specific data, including your flexifields. 

• Data Import module: Switching to the iMed MS documentation system is made even 
easier through the use of an external module called “iMedImport”. In a few simple 
steps, this assistant allows you to import your existing data in text or Excel format 
directly into an iMed database. 

• Enhanced data export: iMed can now export full information about selected patients, 
including your flexifields, in plain text, Excel or XML. 

• iMed Update: To make sure that you are running the latest version, iMed can 
automatically detect and install new versions or corrective patches when they become 
available. 
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• Registration: Registering your copy of iMed is necessary to obtain an optimal 
support from the iMed Support Team, and benefit from the new iMed Update feature. 

• MS diagnosis criteria: Information relevant to the MS diagnosis and disease course 
is now grouped in a single convenient location within iMed. In addition, iMed 
determines from the information you have entered whether the Mc Donald criteria1 for 
spatial dissemination of brain lesions are fulfilled. iMed also includes a tutorial 
presenting contemporary guidelines from an International Panel on the diagnosis of 
MS, illustrated with sample magnetic resonance imaging scans. 

• Family history: iMed now lets you record the history of MS and other diseases in 
each patient’s family. 

• Linked documents: In addition to free-form notes, you can add links to relevant 
documents on your computer or on the Web. 

• Audit trail: If needed, iMed can track all actions performed on the database and 
produce a log file for auditing purposes. 

1.3 About this Manual 

This manual is intended to provide a comprehensive overview of all the information you 
need to get started with iMed, and to make best use of its powerful functions. The 
chapters are designed to allow new users to understand and use iMed as quickly as 
possible. 

The manual assumes that readers are comfortable using Microsoft Windows. If you are 
new to Windows, you may find the online help useful, which you can access by pressing 
the Start menu on your desktop, then Help. 

 

There are a few conventions you should be aware of when reading this manual. 

• Text enclosed in greater and less than symbols (<…>) indicates an instruction for 
what to type, rather than the text itself. For example <drive letter for your CD-ROM> 
will be a single letter that your computer uses to identify the CD-ROM drive. 

• Text in bold indicates a button or menu item that you must click. 

 

 

 

                                                
1 The Mc Donald criteria for spatial dissemination of brain lesions refers to: 

McDonald WI, Compston A, Edan G et al. Recommended diagnostic criteria for multiple sclerosis:  
Guidelines from the international panel on the diagnosis of multiple sclerosis. Ann Neurol 2001; 
50:121-127; and Polman CH, Reingold SC, Edan G, Filippi M, Hartung HP, Kappos L, Lublin FD, 
Metz LM, McFarland HF, O'Connor PW, Sandberg-Wollheim M, Thompson AJ, Weinshenker BG, 
Wolinsky JS.  Diagnostic criteria for multiple sclerosis: 2005 revisions to the "McDonald Criteria". 
Ann Neurol. 2005 Dec; 58(6):840-6. 
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2 Getting Started 

2.1 Minimum System Requirements 

Before you try to install iMed, you should check that your computer meets the following 
minimum system requirements to enable the program to run: 

Component Requirement 

Processor  Intel Pentium or compatible 

Operating system  Microsoft Windows NT, 2000, XP, Vista, Seven 

System memory  At least 32 MB RAM 

Hard disk space At least 20 MB free disk space 

Display resolution At least 1024 x 768 pixels  

 

iMed has also been verified to run fine on Apple Macintosh systems over virtualisation 
software like Parallels and VMWare. 

2.2 Installing iMed 

Before you start to install iMed, we recommend that you close any other Windows 
applications that you are running. When you are ready to install, insert the iMed 
installation CD into your CD-ROM drive. 

To start the installation, run the iMed Setup program located on the iMed CD: 

<CD-ROM Drive Letter>:\iMed60Setup.exe 

 

Read the iMed Software License Agreement and click Yes. Follow the instructions on the 
screen.  

You have three ways to install iMed: 

1. To start a new database, select Install a new iMed 6.0 program and database and 
click Next. In the next dialogue box, you can choose between a stand-alone or 
network installation. 

• To use iMed on a single PC, select Stand-alone Installation and click Next. 
Then, choose the location where iMed must be installed. 

• To share a database amongst several users, select Network Installation and click 
Next. Then, choose a location on the PC for the iMed program, and another 
location on the network for the iMed database files. See section 5.3 to learn more 
on sharing an iMed database amongst several users. 

2. To install only the iMed 6.0 program, and connect to an existing version 6.0 database 
on your network, select Install a new iMed 6.0 program only and click Next. You 
will be asked to choose a location where the iMed program must be installed, then to 
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find where the existing iMed database is located on your network. See section 5.3 to 
learn more on sharing an iMed database among several users. 

3. To update a previous version of iMed, select Update a previous version and click 
Next. You must then specify the folder where the previous iMed program was 
installed (by default C:\iMed). Your current patient database will be automatically 
converted to the iMed 6.0 format, a process that may take a few minutes if you have 
many patients. 

In the next dialogue box, press Done to initiate the installation process. When the 
installation is completed, press Done to exit the setup program. 

You are now ready to start iMed. 

2.3 Starting iMed for the First Time 

Start iMed by pressing the Start button on your desktop, then choosing iMed from the 
Programs menu, or simply double-click the iMed shortcut icon located on your desktop. 

If you were using a previous version of iMed, all your iMed data were automatically 
transferred into the current iMed during the program update process. In addition, your 
iMed Username and Password remain unchanged. iMed will start immediately, and you 
will be prompted to login. 

If you are using iMed for the first time, and you are not upgrading from a previous version 
of iMed, a User identification form will appear asking for information about yourself. In 
particular, you will be prompted to choose your iMed Username and Password. 

Note: Your Username and Password are case-sensitive. 

You will only need to enter this information when you use iMed for the first time. However, 
you will be prompted for your iMed Username and Password each time you start iMed in 
the future. 

When you have finished entering the information requested, click the Save button. It is not 
mandatory to fill out all fields in this form, and you can still modify the information later 
through the iMed Preferences. When the message “You registered successfully” appears, 
click the OK button. 

iMed will start, and a dialogue box will prompt you to enter your iMed Username and 
Password. 
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2.4 Registering iMed 

The iMed software is developed and distributed freely by Merck Serono. New installations 
are limited to 5 patient records until an iMed Licence number is entered. 

Registering your copy of iMed gives you the right to use the software according to the 
terms of the Software Licence displayed at the program installation. 

Registered users will benefit from support and can obtain new versions of iMed as they 
become available (see 5.1 iMed Update). 

The Registration panel will appear at each start-up until your copy of iMed is registered. 

 

If you do not wish to register at this time your copy of iMed, click the button Register 
Later. 

To obtain an iMed licence, please click the button Register Now. You will be 
automatically directed to the online iMed registration server. Fill-in the Registration form 
and an iMed licence number will be sent to your email address. 

When you receive your iMed Licence number, please enter it in the appropriate fields in 
the Registration panel in iMed and click the Save button. 

 



iMed 6 User Manual 11 

3 iMed Basics 

3.1 Starting iMed 

This section gives an overview of iMed, and a brief description of its main features. It also 
introduces the names of those features, which will be used in the rest of the manual. 

Start iMed by pressing the Start button on your desktop, then choosing iMed from the 
Programs menu, or simply double-click the iMed shortcut located on your desktop. 

iMed will start, and a dialogue box will prompt you to enter your iMed Username and 
Password. 

 

 

You should enter the username and password that you chose when you installed iMed, or 
the username and password that were given to you by the administrator of that iMed 
database. 

Once you have successfully logged in, the iMed application window will appear. 

 

 

If you are using your database for the first time, there will be no patient record in your 
database and the iMed patient browser will be empty. You can begin adding new patient 
data immediately. 
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3.2 The iMed User Interface 

The functions of the iMed software are organised in five Views accessible from the 
Sidebar at the left of the screen. Each View provides access to a different screen with 
specific capabilities. The illustration below shows the Patient records view. 

 
The Sidebar 

 

The record Browser 

The Button bar 

 

 

The Display panel 

Note: Patient names that appear in this User Manual are totally fictitious. 

 

3.2.1 The Menu 

The Main Menu provides the following entries: 

• File: This menu provides data saving, import/export and printing options. It also 
allows you to exit iMed. 

• Edit: This menu provides the usual clipboard functions, and access to the iMed 
Preferences (see section 3.5 ‘Customising iMed’). 

• Tools: This menu provides access to advanced features including multiple user 
management, database management, data quality control, audit trail and flexifields. 
These features are only available to users with ''Administrator'' rights. They are 
documented in section 5 ‘Advanced Features’. 

• Help [?]: This menu provides direct access to the iMed user manual, and to 
information about your installation of iMed, including the location of your database if 
you are logged in as an iMed administrator. It also gives access to online iMed 
updates (see section 5.1). 
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3.2.2 The Sidebar 

The Sidebar is divided in two parts. The upper part contains five buttons allowing you to 
access the different Views. 

• Patient records: browse through the patient directory, view and enter data for a 
specific patient; 

• Statistics: a powerful graphical view of multiple patient records; 

• Care Professionals: a directory of the persons involved in the care of the patients; 

• Calendar: a calendar of events, appointments; 

• MSBase: contribute with anonymous data to the MSBase patient registry. 

The lower part of the Sidebar contains filters or links to frequently used queries. 

3.2.3 The Browser 

The Browser is divided in three columns reflecting the organisation of the pages of the 
medical record (see section 3.4 'Data organisation'). 

Select a Patient from the list (first column) and use the keyboard or the mouse to move 
quickly between the pages of the medical record. 

 

3.2.4 The Button Bar 

The buttons in the Button bar are ''context specific'', i.e. they appear according to the 
needs of the View selected. These buttons are used consistently throughout iMed. 

 

 

 

 

 

 

 

Cancels all changes 
that have been made 
to the active page 

Saves changes that have 
been made to the page Deletes the patient 

record selected 

Prints the current 
patient record 

Adds a new  entry 

Creates a new 
patient record 

Deletes the entry 
selected 

 
 
Click in the patient list and 
then press any key to jump 
to the first patient name that 
starts with that letter. 
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3.2.5 The Display Panel 

In the Patient record view, the Display panel is the area below the Button bar where the 
page selected in the record Browser are displayed. 

In the Statistics view, the Display panel shows a graphical representation of the statistic 
selected from the Button bar. 

3.3 Creating a Patient Record 

To add a new patient into the iMed database, first select the Patient records view in the 
sidebar on the left of the screen. Then click the button  located below the 
column labelled ''Medical records''. 

The first page of the medical record will appear in the Display panel, ready for you to fill 
out. 

 

You must provide at least the minimum patient identification data: the patient’s first and 
last name, date of birth, and gender. Without this information, you will not be able to save 
the patient record. 

Most of the patient data is optional. Fill out as much of the patient profile as you wish, and 
then click the button  to store the information in the database. Your new 
patient record will appear in the patient browser. 

 

 

 

 

 
 
You can also press CTRL+S 
to save the patient record. 
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3.4 Data Organisation 

The iMed patient record is organised in Pages logically grouped in six different Sections. 
The data structure is illustrated in the ‘tree’ diagram below. 

To view or edit a patient record, select the Patient, the Section and finally the Page using 
the record Browser. 
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3.5 Customising iMed 

Some aspects of iMed can be customised to your particular needs. 

Click on Edit in the menu bar, then select Preferences. This will display a screen that lets 
you change the following features of iMed. 

• Center Information – to modify the Center name and address, the date format used 
for display and the paper format for printed reports. If you are an iMed administrator, 
you can enable or disable the Audit trail feature (see section 5.4). You can also add 
your Center’s logo, which will be incorporated in iMed-generated reports. Use the 
Add button to add an image from your file system. Most common image types are 
supported (JPG, GIF, PNG, etc.). To delete the logo, click the Delete button. 

• User Information – to modify your user name and address, to specify which tabs will 
be displayed in the Visits section, and therefore what types of information you can 
enter in the Visit page, or to modify the language of the iMed menus and dialogue 
boxes. There are 10 available languages: Brazilian, Dutch, English, Finnish, French, 
German, Italian, Portuguese, Russian and Spanish. Note: iMed will restart when you 
switch languages. 

• Family Relationship – you can add or delete degrees of family relationship from this 
list. 

• Ethnic Origin – you can add or delete ethnic groups from this list. 

• Medical Events and Conditions – you can add or delete diseases from this list. 

• MS-Specific Treatments – you can add different drugs and treatment regimens to 
this list. 

• Symptomatic Treatments – you can add different drugs and treatment regimens to 
this list. 

• Non-Pharmacological Treatments – you can add or delete treatments from this list. 

• Corticosteroid Schedules – you can create your own corticosteroid schedules. 

• Care professionals – you can create your own lists for Titles, Functions and 
Locations. 

• Calendar – you can create your own list for Category of event. 

Once you have made all the changes you want, click Save. Your new preferences will be 
applied immediately. 
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4 iMed Step-By-Step 

4.1 Patient Records 

4.1.1 Creating a Patient record 

To add a new patient into the iMed database, first select the Patient records view in the 
sidebar on the left of the screen. Then click the button  located below the 
column labelled ''Medical records''. 

The patient ''Identification'' page will appear in the Display panel, ready for you to fill out. 

 

iMed automatically assigns a numerical iMed Patient ID, but you can also enter your own 
patient code in the field ''Patient code'' for cross-reference with other information systems. 

Fields with a label in bold are mandatory, others are optional. 

You must provide at least the minimum patient identification data: the patient’s first and 
last name, date of birth, and gender. Without this information, you will not be able to save 
the patient record. 

Most of the patient data is optional. Fill out as much of the patient profile as you wish, and 
then click the button  to store the information in the database. Your new 
patient record will appear in the patient browser. 

The first page of the patient record is now completed. Use the Browser to select the 
following pages of the patient record, i.e. Medical History, Diagnosis and Notes. 

The Medical History page allows you to document the patient’s entry in your clinic, and 
provides an overview of the patient’s medical history, including concomitant diseases and 
family disease history. 

The Diagnosis page groups all details relevant to the patient’s MS diagnosis: date of 
onset of the disease, first symptoms, date of progression, and MS classification according 
to McDonald (see reference on page 6) and Poser. Poser refers to Poser CM, Paty DW, 
Scheinberg L et al. New diagnostic criteria for multiple sclerosis: guidelines for research 
protocols. Ann Neurol 1983; 13:227-31. 
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If you have customised iMed to add personal structured information in the section Patient 
profile (see 5.3.1 for details on the 'Flexifields') an extra page Flexifields will appear 
before the page Notes. 

The Notes page can be used to enter any additional information as free-form text, and 
also to store links to various documents on your computer or on the Web. You can use the 
'copy & paste' functions to quickly include notes from other applications and documents. 

4.1.2 Deleting a Patient Record 

In the first column of the Browser, select the patient record you wish to delete and click 
the button . You will be asked to confirm that you want to delete this record. 

Please note that deleted patients are simply hidden in the database. If needed, it is still 
possible to ''reactivate'' the record. To do so, click on the Search button to display the 
Search panel. Click on Include deleted patients in search and press the button Search. 
The records retrieved will be listed in the Browser. Deleted records will appear in red 
colour. Open the patient record that you wish to reactivate and press the button Save. 

4.1.3 Adding Patient Data 

Once you have provided the basic Patient profile information, you can use the different 
sections of the Patient record to document other aspects, such as Visits, Relapses, 
Paraclinical tests, Treatments... 

The third column of the Browser will be empty when you click on the different Sections 
(second column), until some data is recorded in the database. 

 

To report new data, select the appropriate Section (second column) in the Browser and 
click the button  located under the third column. 

The process for specifying the new data will vary slightly depending on the section 
selected. The specific steps for each section are described below. 

4.1.4 Visits 

The section Visits stores data on the neurological status of your patient at each visit. Click 
on the button  to add a new Visit to the patient record. 
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You must specify the visit date when the neurological status of the patient was assessed. 

It is possible to create visits retrospectively, simply by typing a date in the past. If you are 
not sure of the exact date of the assessment but you do know the month and the year, 
you should enter the 15th of the month. If only the year of the visit is known, you should 
record the assessment as occurring around the middle of that year. 

The ‘Visit' page displays several tabs: ‘Basic’, ‘EDSS’, ‘Safety’ and ‘Notes’.  

 

• Basic describes the purpose of the visit, the patient’s history since the last visit, and 
evaluations of impairment levels. The current MS classification and disease course 
are displayed here for reference, but can only be modified in the Diagnosis form 
under the Patient Profile section. 

• EDSS calculates the EDSS score based on the Functional System Score and the 
patient ambulation capacity of the patient. You are also prompted to enter an EDSS 
manually – this can be the same as the calculated one or different, according to your 
clinical opinion of the patient. 
Your EDSS score only is recorded in the iMed database. The Functional System and 
Ambulation scores can be documented according to the Neurostatus format or the 
original Kurtzke format. 
The EDSS requires a Functional System Score be entered by the user for each factor 
which is part of the scale. The iMed software then uses a calculation method based 
on its own free interpretation of the above article to suggest an EDSS score. There is 
no single accepted interpretation and this software provides only one of many 
possible interpretations. In addition the overall EDSS level shown will vary according 
to the Functional System Score assigned to each factor by the individual User. The 
EDSS level suggested by iMed for one patient may vary therefore and is intended for 
general informational purposes only. User has full and final responsibility for the 
analysis, review and assessment of data shown, including the EDSS score. 
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The Kurtzke Expanded Disability Status Scale (EDSS) refers to a methodology 
described in: John F. Kurtzke. Rating neurologic impairment in multiple sclerosis: An 
expanded disability status scale (EDSS). Neurology 1983;1444-1452. 
Neurostatus refers to a slightly modified version of the standardised neurological 
examination and assessment of Kurtzke’s Functional Systems and Expanded 
Disability Status Scale. 

• Safety allows you to report changes in the medical condition of the patients, such as 
malignancies, infections, allergies, adverse events etc. 

• Notes can be used to enter any additional information as free-form text, and store 
pointers to relevant documents on your computer or on the Web. 

 

Optionally, you may display additional tabs by clicking on the "+" tab located at the right of 
the last tab. The optional tabs are: ‘Symptoms’, ‘Scripps’, ‘MusiQOL’ and ‘Flexifileds’.  

 

• Symptoms allows you to select all the patient’s symptoms at the time of the visit, 
from a predefined list sorted by functional systems. 

• Scripps allows you to calculate the Scripps score for the patient by adding the total 
number of points for each answer you have entered on this screen based on your 
individual assessment of a patient. To obtain this score, you must complete all the 
entries on this screen. The Scripps Neurological Rating Scale is a 22-item ordinal 
impairment scale that converts the neurological examination with a three level scoring 
system, with scores ranging between 100 (normal) and 0 (worst). The reference for 
Scripps is: Sipe JC, Knobler RL, Braheny SL et al. A neurologic rating scale (NRS) for 
use in multiple sclerosis. Neurology 1984; 34:1368-72. User has full and final 
responsibility for the analysis, review and assessment of data shown, including the 
Scripps score. 

• MusiQoL allows you to report the patients’ quality of life according to the MusiQoL 
scale, referred to in: Simeoni et al, Validation of the Multiple Sclerosis International 
Quality of Life questionnaire; MusiQol study group. Mult Scler. 2008 Mar;14(2):219-
30. 

• If you have customised iMed to add personal structured information to the Visits 
section (see 5.3.1 Flexifields for details), an extra tab Flexifields will appear before 
the ‘Notes’ tab. 

Once you have finished entering data in the Visit page, click the Save button. 

All the Visits created will be listed in the Browser, sorted in descending order. 
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4.1.5 Paraclinical Tests 

The results of the paraclinical tests should be reported in the section ‘Paraclinical Tests’. 

Select the section ‘Paraclinical Tests’ in the Browser, and click the button . iMed will 
prompt you to indicate what type of test result you want to report. 

 

If you have customised iMed to add your own paraclinical tests (see 5.3.1 'Flexifields' for 
details), an extra button Flexifields will appear in the list of tests. 

Click on the appropriate button and the corresponding page will be displayed in the 
Display panel. 

The MRI page allows you to record details of MRI scans, such as the date of the scan, the 
location of the scan, and the number of lesions. 
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Based on the information you supplied, iMed determines automatically whether the 
McDonald criteria for spatial dissemination of brain lesions are fulfilled. By clicking the 
button , you can launch a tutorial presenting contemporary guidelines from an 
International Panel of experts on the diagnosis of MS, and illustrated with sample MRI 
scans. 

Images can be attached to each MRI scan in the tab Images. To add an image from your 
file system, click the button  located at the bottom-right of the screen. Most common 
image types are supported (JPG, GIF, PNG, etc.). The images are copied into the iMed 
database and shown as a new thumbnail at the bottom of the screen. 

To delete an image, select it and click the button  at the bottom-right of the screen. 

 

Select an image thumbnail to display the full picture in the large viewing area above the 
thumbnail. 

As you move the mouse over the large image, a dotted square follows your movements to 
track the zoom area. Click on the detail you want to view and it appears in the zoom view 
on the right. A solid red square on the main image shows the detail location selected. 
Move your mouse elsewhere and click again to zoom on another detail. You can adjust 
the magnification level with a four-position cursor located above the zoom view. 

 

The CSF page allows you to store details of a CSF assessment. 

The Evoked Potentials page enables you to indicate ‘Normal’, or ‘Abnormal’ results for 
these tests. 

The Laboratory Tests page allows you to enter values for haematology, blood chemistry, 
thyroid function, immuno/virology and other tests. In each case, you can indicate whether 
or not the values are outside the normal range. 

Once you have finished entering data on the chosen paraclinical test, click the Save 
button. 

The paraclinical tests you reported are then listed in the 3rd column of the patient Browser, 
sorted by descending date. 
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4.1.6 Medical Events 

The ‘Medical Events’ section stores information on Relapses, Adverse Events and 
Pregnancies. 

Select the Medical Events section in the patient browser, and click the Add button. iMed 
will prompt you to indicate what type of medical event you want to add. 

Click on the desired button to display the relevant medical event page: 

• The Relapse page allows you to record information such as the date when the 
relapse began, its duration, and the affected CNS region. 

• The Adverse Event page includes information on severity, drug relationship and 
outcome. 

• The Pregnancy page includes details of the pregnancy, complications and birth, 
abortion or miscarriage. 

• If you have customised iMed to add your own kind of medical event (see details in 
section 5.3.1 Flexifields), an extra button will appear in the list of tests. 

Once you have finished entering data, click the Save button. 

Each clinical event you add is shown in the 3rd column of the patient browser, sorted by 
descending date. 

4.1.7 Treatments 

The Treatments section stores information on your patient’s treatments. 

Select the 'Treatments' section in the patient browser, and click the Add button. iMed will 
prompt you to indicate what type of treatment you want to add. Click on the desired button 
to display the corresponding Treatment page. 

Several fields in this page, such as the treatment name, let you choose from a list of 
options. The lists can be edited in the iMed Preferences screen (see section 3.5: 
Customising iMed). The button  on the right of the list provides a shortcut to the iMed 
Preference screen. 

If you do not find the relevant option in the list of values, click on the button . You will 
be directed to the iMed Preference. Add the new value in the list and press the button 
Save. The list is now updated and you can select the appropriate value in the field. 

Once you have finished entering data on the treatment, click the Save button. 

The treatments will be listed in the 3rd column of the patient Browser, sorted by 
descending start date. 
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4.1.8 Summary Graph 

When you select a patient in the patient browser, a graphical representation of the patient 
medical history (course of MS, relapses, visits, treatments...) is displayed in the Display 
panel. 

 

Events and treatments are shown as colored horizontal bars on the chart. Names of 
treatments are displayed inside the green bars. Visits are shown as vertical red lines on 
the appropriate date. MRI scans are shown as blue diamonds. 

A double-click on a graphical element (Visit, Relapse...) automatically opens the patient 
record on the corresponding page. 

You can change the timescale of the chart using the drop-down control. The default 
choice of 'Maximum' will set the chart to display even the oldest events, visits and 
treatments for that particular patient. You can choose other values to “zoom” in and out 
using different time scales. 

 

When you move your mouse over various graphical elements in the chart (such as visits, 
relapses and treatments) the shape of the pointer changes to a hand. Leave the pointer 
on the graphical element and a little pop-up window will display additional details. 
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4.2 Searching the iMed Database 

Searching the iMed database is a simple process. All you have to do is to enter one (or 
more) Search criteria in the Search panel. 

To make a search, press Search patients... in the Sidebar. The Search panel will appear. 
Use the fields Section, Page, Criteria, Operator and Value to build your search criteria. 
Then press the button Search to run the query. 

The example below shows a query to find all patients with an EDSS < 4.0. 

 

If you wish to build a query to find patients who meet more than one search criteria, select 
AND or OR in the first box in the second row, and enter the second search criteria. If 
needed, enter a third search criteria. Then press the button Search. 

For complex queries involving more than three search criteria, it is possible to run a query, 
then run a second query based on the outcome of the first query. To do so, click on the 
checkbox Search in current list (located on the right side of the Search panel) before 
you run the second query. 

The Search panel also includes a checkbox that allows you to Include deleted patients 
in search, so that you can retrieve patient records that were previously deleted. These 
records are shown in red in the patient browser. You can restore a deleted patient record 
by clicking the Save button. 

Four buttons appear at the bottom left of the Search panel: 

• Last Query: Press this button to recall the last query that was executed. The 
corresponding search criteria are filled in automatically. Press Search to run the 
query. 

• Clear Query: Press Clear query to clear the search criteria 

• Load Query: Press this button to display a list of previously saved queries, then 
select the one from the list and press OK. The corresponding search criteria are filled 
in automatically. Press Search to run the query. The saved queries are also listed in 
the Sidebar. Simply click on a query in the list to execute it without even having to 
open the Search panel. 
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• Save Query: For your convenience, queries can be saved and reapplied at a later 
stage. To save a query, simply enter your search criteria and click the button Save 
Query. Then type a suitable query name in the dialogue box and click OK. Please 
note that the queries saved are also listed in the Sidebar. 

When you wish to retrieve all the patient records, simply click on Show all patients in the 
sidebar. 

4.3 Printing Patient Information 

Use the menu Print or the button  to generate a print out. The following pre-
defined reports can be printed: 

• The Listing of patient records generates a listing of all patients currently selected. 

• The Patient status report gives a summary view of the selected patient’s medical 
history, current disease status and ongoing MS specific therapy. 

• The Summary graph provides the same information in a graphical way. 

• The Templates choice allows you to print a custom report designed with the separate 
iMed Reporting Module (see section 5.6). 

• If you are based in Switzerland, iMed also offers to print the German or French SVK 
report. 

• If you are based in Denmark, you can print the Kontrolskema report. 

• If you are based in Italy, you can print detailed Scheda Clinica reports specially 
tailored to your national requirements. 

You can choose to print immediately or preview the report before printing. In the Preview 
window, you can zoom in on the pages that are being previewed, print the pages, or exit 
from the preview, and therefore cancel the print command. 

The Page Setup menu lets you change the default printer and page settings. The default 
paper size can also be defined in the iMed Preferences, under the Center Information 
heading. 
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4.4 Statistics 

The Statistics View allows you to display summary statistics for all your patients, or for a 
sub-set of patients. 

The upper frame of the Statistics View displays your list of patient records. Click on a 
column header to sort the records by that column’s data. Click the same header again to 
invert the sort order. 

The lower frame can display the distribution of several parameters: the MS course, the 
EDSS score at last visit, the relapse rate, the age at onset of MS, the duration of MS and 
the ongoing MS specific treatment. 

 

When patient records are selected in the upper part of the Statistics View, they are also 
highlighted in the lower frame. And vice-versa. 

Multiple selections are also possible by pressing the Ctrl key and clicking on the records 
in the list, or on the bars in the graph. 

4.4.1 Selecting a Sub-sets of Patients 
A click on a bar in the graph will automatically select the corresponding patient records. 
For example, if you are interested by the sub-set of patients who have had MS for more 
than 30 years, select the graph ‘Duration of MS’ from the drop-down menu, then click on 
the bar that corresponds to ‘>30 years’ in the lower frame. The bar will now be highlighted, 
as well as the corresponding records in the upper frame. 
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If you then choose to display another graph, the records selected initially will remain 
highlighted. 

4.4.2 Zooming into a Sub-sets of Patients 
To display only a sub-set of patients, make a selection of records using one of the 
methods described in the previous section (for example by clicking on a bar in the lower 
frame). Then press the button  in the button bar. 

Following the previous example, the graph would look like the illustration below: 

 

You can also display a particular sub-set of patient records using a stored query, simply 
by clicking on the corresponding query in the Sidebar. 

When you want to select again all the patients in the database, simply click on Show all 
patients in the sidebar. 



iMed 6 User Manual 29 

4.5 Care Professionals 

The View Care professional stores a directory of all persons involved in the care of the 
patients. 

 

To add an entry in the list, simply click on the button New in the Button bar. 

 

You can use the button  to create your own list for Title, Function and Location. 

To delete an entry, select the person in the list and press the button Delete. 

The button Print allows you to print a listing. 

It is also possible to import one or several files at the vCard format. To do so, simply 
choose Import in the File menu, and select a file at the vCard format. The data imported 
will be displayed in the list of Care professionals. 
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4.6 Calendar 

The View Calendar displays a calendar of events. You can use it to schedule events, 
visits, laboratory tests etc. The Patients and Caregivers stored in the other Views can be 
associated to the Events. 

Events can be displayed in Calendar format - by day, by week or by month – and in List 
format. Use the button  to select the appropriate representation. 

  

 
To create a new Event, press the button , or simply double click on the 
appropriate day in the Calendar. The Event window will be displayed, ready for you to fill-
in. 

 

The field Category allows you to categorise the events according to your needs. You can 
use the button  to create your own list of Categories. 

The button Print allows you to print the Calendar view in the actual format . 

To export the Events, select Export from the File menu, and choose a file name. iMed will 
generate a file that can be open by all systems compatible with the vCal standard, like MS 
Outlook, Apple iCal. 
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4.7 MSBase 

iMed allows you to contribute to MSBase, the International MS Registry, available on the 
internet at www.msbase.org. 

Only data about patients that you choose to enrol will be sent to MSBase. Personal 
information, such as patient name and address, is never included in the data transmitted. 
Data is sent directly from iMed to the MSBase web server through an encrypted Internet 
connection. 

Once you have sent patient information to MSBase, you will be able to benchmark your 
data against the entire MSBase cohort, or even specific sub-studies. You can also use the 
MSBase Forums to discuss your findings with other MS researchers around the world. 

You may only use this feature of iMed after you have registered on the MSBase web site. 
To learn more about how to join MSBase, please visit www.msbase.org. 

4.7.1 Enabling data transfer capacity 

If your institution is registered at the MSBase Registry, the Principal Investigator for your 
institution should have received a MSBase Personal Identification Number (MSBase PIN) 
from the MSBase Foundation. 

Before you enable the MSBase communication feature in iMed, the MSBase View should 
look as follows: 

 

On the MSBase View in iMed, enter the MSBase PIN in the dedicated field, and press 
Validate. 

Once enabled, the MSBase View should now look like this: 
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The right-hand side of the screen provides the patient status regarding MSBase. The 
record can be Eligible, Enrolled, Complete. The symbol  in the column 'Enrolled' 
indicates that you have not yet decided to enrol the patient on MSBase. 

Use the button  to enrol the appropriate patients on MSBase. 

4.7.2 Sending Data to MSBase 

To send data into your MSBase account directly from iMed, your PC should have an 
Internet access.  

Review your list of patients not yet enrolled, and enrol additional patients if appropriate. 

Then press the button  . 

iMed generates an anonymised dataset compatible with MSBase. At the next prompt, 
enter your MSBase Username and Password and press the Submit button. 

The dataset is sent directly to your MSBase account. The process may take a few minutes 
depending on the number of records to upload and the speed of your Internet connection. 

Note: If your PC has no Internet access or if for some reason the data transfer fails, you 
still have the option to transfer your dataset from MSBase. From your Internet browser, go 
to www.msbase.org and log in using your MSBase Username and Password. Then go to 
My data > Upload data. Click the Browse button and locate the MSBase dataset 
previously generated by iMed. This dataset is called "MSBaseExtract.xml.gz" and is 
located under the iMed folder in a sub-folder "MSBase_Dataset" (the path is probably 
c:\iMed\MSBase_Dataset\MSBaseExtract.xml.gz). Press Submit to upload the dataset 
into your MSBase account. A confirmation is displayed when the data transfer is 
completed. 
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5 Advanced Features 

5.1 iMed Update 

New versions of iMed can be downloaded and installed automatically. When a new 
version is available, iMed will offer to install it the next time you start the program. If you 
do not wish to install the new version immediately, you can get on with your work and take 
care of the update later via the ‘iMed Update…’ entry in the Help ‘?’ menu. 

The iMed Update panel will guide you through the update process. 

 

After iMed has finished downloading the new version, you can either install it immediately 
or keep it for later. In that case, the next time you start iMed, it will remind you that the 
new version is ready and offer to install it. 

If you are using iMed with a shared database, the first person that installs a new iMed 
version will convert the database to the new format if necessary. In that case, other users 
will be warned that the database format has changed and guided to install the 
corresponding iMed version. To ease such networked installations, the new iMed 
installation program is ready to deploy in the same directory as the shared iMed database, 
in a directory named ‘Update’. iMed administrators can change this default location via the 
‘Tools / Database Path’ menu. 

Note: The iMed Update feature is only available to registered copies of iMed. 
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5.2 Managing User Accounts 

iMed allows you to share an iMed database among several users and to finely control 
access to patient records depending on each user’s needs. 

In a single-user installation, iMed installs its database on the local computer and grants all 
privileges to the user. In a multi-user setup, you can define user accounts choosing 
among four types to grant appropriate rights and data access privileges: 

• Administrator: can read and write all patient records, create new users, import data, 
backup and restore the database, enable the audit trail and define flexifields. 

• Normal user: can read and write all patient records. 

• Private user: can read and write his/her own patient records only. 

• Limited user: can read all patient records, but not write any data. 

The first account created during iMed installation is always an Administrator. Further users 
can be created via the menu Tools > User Management… 

5.3 Managing iMed Databases 

5.3.1 Flexifields: Adding Personal Structured Information 

iMed was designed by neurologists for neurologists, so it can immediately handle most of 
the information typically required to follow-up MS patients clinical condition. However, 
when iMed is your main data repository, you may want to add extra fields that are relevant 
to your practice or your research interest. Extra fields can be added either as free-form 
text in the standard iMed ‘Notes’ page, or as structured information using the ‘Flexifields’. 

Flexifields are additional fields saved in the iMed database alongside the standard pages. 
The Flexifields can be defined in iMed’s four familiar sections: Patient Profile, Visits, 
Paraclinical Tests and Medical Events. 

To create a Flexifield, select 'Flexifiels' in the menu 'Tools', then choose the appropriate 
Section and enter the flexifield Name and Type. You can also define a Unit and a normal 
range. 

In the example below, a flexifield is created under the section ‘Visits’ to capture the weight 
of the patient. The field name is 'Weight', the type is 'Numeric' and the Unit is 'Kg'. 
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Text fields can contain up to 250 characters. Date fields use the date format chosen in 
iMed preferences. Fields can be reordered using the arrow buttons. 

When flexifields are defined, a new page labelled 'Flexifield' is displayed in the 
corresponding Section. For example, the flexifields 'Weight' defined in the previous 
illustration will appear in a new tab labelled ‘Flexifields’ on the Visit page. 

 

5.3.2 Sharing a single Database 

To share an iMed database with other users, the iMed database files must be installed on 
a shared drive over a network (LAN). 

Typically, network installations are slower than stand-alone installations. For best 
performance, you should run the iMed application from your local hard-drive and keep the 
iMed database folder on the network. 

Users with Administrator privileges can select locations of their iMed working database, 
backup database, additional resources and iMed Update downloads, through the menu 
‘Tools > Database Path…’. 

5.3.3 Backing Up and Restoring a Database 

To back up your iMed database, select Backup in the Tools menu. Choose a name and a 
location for the iMed backup file, and press Save. 

To restore data, select Restore in the Tools menu. Select the iMed backup file to restore, 
and click Open. This procedure will replace ALL data in your iMed database with the data 
from the backup database. 
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Note: it is only possible to restore a database at the same version. For example, it is not 
possible to restore a database version 4.5 in a database version 5.5  

5.3.4 Data Quality Check 

Through the menu ‘Tools > Data Quality Check…’, iMed can perform a complete check of 
your patient database and report missing or inconsistent data. The Data Quality Check 
window lets you display and print Errors, Warnings or both. 

 

Warnings relate mainly to missing or inconsistent data. Errors relate to impossible data, 
like for example a date of visit that would occur prior to the date of birth... 

The list of Errors / Warnings can be printed for easy reference. 

5.4 Audit Trail 

5.4.1 Enabling the Audit Trail 

The Audit Trail functionality can be enabled by an iMed administrator via the Center 
Information screen on the Preferences panel. 

5.4.2 Providing Reasons for Changes 

When the Audit Trail is enabled, iMed tracks all changes to the database, including data 
modification, addition and deletion, the date and time, the author and the reason for the 
change. Every time a user saves changes from a data entry form, iMed lists the fields that 
were modified and asks for the reason of the change. 
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You can enter a different reason in front of each modified field, or you can copy the same 
reason for all the changes by clicking the button Copy Reason. Then click the button 
Save to record your changes. Note that you cannot cancel your changes from the Audit 
panel. If you have made a mistake, you must first save the data, then change what was 
wrong in the page, and provide a new audit reason, such as “Correcting mistake”. The 
purpose of the Audit Trail is to track every action on the database… 

5.4.3 Displaying an Audit Report 

Audit reports can be viewed by administrator users via the menu ‘Tools > Audit Trail…’. 

 

In addition to the dates, users and reasons for changes, the audit report shows the field 
value before and after changes. By default, the report displays all changes since the Audit 
Trail functionality was enabled. You can choose to display only changes made by a 
particular user, or select only certain actions (Add, Modify, Delete) or limit the report to a 
range of dates. 

You can also sort the audit report by clicking on the desired column heading, i.e. click on 
the Patient header to sort all changes by patient name in alphabetical order. Click the 
same header again to invert the sort order. By default, the audit report is sorted by date 
and time. 
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5.5 Exporting and Importing Data 

The File menu gives you access to data export and import facilities. 

5.5.1 Exporting Data 

The Export menu opens a dialogue box where you can choose the file name and 
location where you want to export your patient data. By default, it starts in your 
local iMed installation directory. Besides the name and location, you can choose 
among several export formats in the Save as type pop-up list: 

• Text File (*.txt) creates standard tab-delimited text files, enabling you to import the 
data into a statistical package or a spreadsheet. Each file includes field names in the 
first line. The character encoding is Windows Latin-1 and the date format is the one 
you have chosen in iMed preferences. From the file name you supply, iMed 
generates nine files, named <filename_ID>.txt, <filename_VI>.txt, <filename_RE>.txt, 
etc. These files contain data on the Patient Profile (ID), Visits (VI), Relapses (RE), 
Treatments (TR), Adverse Events (AE) and Paraclinical Tests (MR, CS, EP, LT). 
They are linked by the Patient ID number provided by iMed in the first file. 

• iMed File (*.med) creates a proprietary iMed database file that you can share with 
other iMed users (provided that both sides use the same iMed version). This file 
contains all the information for selected patients. 

• XML File (*.xml) creates an XML file that incorporates the same datasets as the text 
file export described above. You can use this file with any XML-compatible software. 

• Excel File (*.xls) creates a Microsoft Excel file that incorporates the same datasets as 
the text file export described above. Each of those nine datasets appears in its own 
tab in the Excel spreadsheet. 

In all export formats, iMed only exports the list of currently displayed patients. For 
example, you can use the Search function to identify patients with certain characteristics, 
and then export only these patient records. Another way to quickly make a selection is to 
"zoom" on a column in the Statistics View. 

5.5.2 Importing Data 

The Import menu opens a dialogue box where you can choose the file name and location 
from where you want to import some patient data. By default, it starts in your local iMed 
installation directory. Besides the name and location, you can choose between two import 
formats in the Files of type popup list: 

• EDMUS import Files (*.txt) accepts files generated by the EDMUS program version 
2.5 or 2.6  (European Database on Multiple Sclerosis).  Please read the EDMUS User 
Manual for details on how to export an EDMUS dataset. EDMUS generates 5 export 
files, named Idyymmdd.txt, Msyymmdd.txt, Csyymmdd.txt, Tryymmdd.txt and 
Aeyymmdd.txt (“yymmdd” represents the date when these files were generated). Just 
select any one of those files and click the Open button 

• iMed File (*.med) accepts a proprietary iMed database file generated by an iMed 
database at the same version, as described in section 5.5.1. 

iMed will show a progress indicator and status information as the imported patient records 
are added to your iMed database. 
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Warning: When importing data into iMed, all patient records with the same full name, birth 
date and gender will be replaced with the new data. 

 

5.5.3 iMed Import Module 

The iMed Import Module is a separate program located in the iMed installation directory 
(by default C:\Program Files\iMed), and accessible from the iMed program group. 

The iMed Import Module allows you to import any text or Excel data into an iMed 
database by defining your own custom data import template. 

Warning: It is recommended to quit iMed before importing data. If your database is 
shared on a network, all iMed users should be logged out when running the iMed Import 
Module. It is also recommended to backup your iMed database. 

Before importing data into iMed, you should export the relevant data from your other 
software, either in plain text files or as Excel spreadsheets. Imported files should have 
field names in their first row for easy mapping to iMed field names. Also, you should try to 
arrange the import fields in similar datasets as iMed uses (Patient ID, Visits, Relapses, 
Treatments, etc., see section 5.5.1) 

You will be guided through the four stages of the import process: import setup, data 
mapping, error checking and data import. 

Step 1 - Import Setup: Login to your iMed database, choose to import from an Excel 
spreadsheet or a text file, and select the date format and field delimiter used in your files. 

 

 
 
You may wish to backup your iMed database 
before performing an Import operation. 
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Step 2 - Data Mapping: Select your source file(s) to be imported. Be careful to select the 
correct file for each of the 9 iMed datasets or “pages” (Patient ID, Visits, Relapses, etc.) 
For each page, a list of source fields is displayed on the left, and a list of iMed fields on 
the right, including mandatory fields in red. The assistant matches identical field names, 
and you can re-order your source fields to match the iMed import order. Then, please 
choose which fields you want to import or ignore by double-clicking in the middle Relation 
column. 

Once you have selected the desired fields, you can save this mapping by clicking the New 
Template button. Give it a name and you can access it directly next time you want to 
import data from the same source. 

 

Stage 3 - Error Checking: The iMed Import Module is now ready to check for potential 
errors in the files to import. Click the Check for Errors button and tests will be performed 
for each of the iMed pages that you have configured to import. If errors are detected, click 
the Details buttons to learn what is wrong, then return to stage 1 or 2 to solve the problem 
(field separator, date format, data mapping?), or correct your import files accordingly. 
When no errors are detected, you can move on to stage 4. 
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Stage 4 - Data Import: All the patients contained in your import files are listed (last name, 
first name, birth date and gender), and you can choose to import them all or pick only the 
ones you need by double-clicking in the Import column. Patients who seem to already 
exist in your iMed database are highlighted in red to avoid erasing data. If you choose to 
import them, all the existing data will be replaced by the imported data. 

When you click the final Import button, a progress bar is displayed until you are alerted 
that the import is completed. Then you can quit the iMed Import Module and launch iMed 
to access your newly imported data. 
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5.6 iMed Reporting Module 

The iMed Reporting Module, iMedReporting.exe, is located in the iMed installation 
directory (by default C:\Program Files\iMed), and accessible from the iMed program 
group. This program lets you create your own templates of letters and reports with your 
clinic details and logo (e.g. referral letters), and generates customised printouts integrating 
patient-specific data, including your flexifields. 

The iMed Reporting Module works like a simple word processor such as WordPad. You 
can start typing your report directly or you can copy and paste text from another word 
processor. The top toolbar lets you adjust font and paragraph styles and colours. The 
Insert menu lets you add images from your computer (most formats are supported), and 
special characters and symbols. 

 

On the left of the report text, all iMed information fields are available to pick as needed. 
They are arranged according to the familiar iMed database structure (see Erreur ! Source 
du renvoi introuvable.). To insert a field in your report, drag its name from the left 
column into your text on the right. Fields are denoted by %FieldName% placeholders, 
which will be replaced by the actual patient data upon printing. You can also enter these 
placeholders manually, as long as you retain the % % marks around field names. 

The Print button or menu opens a preview window showing the final report including The Print button or menu opens a preview window showing the final report including 
patient data from your iMed database.  
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When you are satisfied with your report, click the Save button and simply choose a 
document name. Your report template will be saved with your iMed database and will be 
available to all iMed users for printing reports from within iMed (see section 4.3 Printing 
Patient Information). 

5.7 RebiSmart™ device 

The injection log stored in the RebiSmart device can be transferred to iMed. 

The adherence rate is calculated by comparing the total number of injections recorded by 
RebiSmart™ medical device during a week from Monday to Sunday with the total number 
of injections set per week which is three (3). The monthly adherence rate is calculated by 
using the weekly adherence rate to create a monthly adherence weighted average. The 
adherence rate does not take into consideration specific days upon which injections were 
made. 

The RebiSmart™ device settings and functions are completely independent from iMed. 

5.7.1 Hardware connection 

To connect the RebiSmart docking station: 

1.  Take the USB cable.  

2. Insert larger end, with the  icon facing down, into the 

rear of the docking station. 
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3. Insert smaller end of the cable, with the  icon facing up, 

into a USB port of your PC 

 

5.7.2 Data transfer 

1.  Turn on the RebiSmart™ device… 

Use the buttons to navigate through the main menu to option 
‘’Connection’’, and select “Open”. 

At the prompt “Start computer first”, select “OK”. 

When you see “Connecting…” on the screen, firmly place 
RebiSmart™ into the docking station. 

 

 

2.  In iMed… 

Got to Tools > RebiSmart download 

Click on “Next >>” to continue. 

 

 

Select the appropriate patient record and click on the “Download 
Data…” button to confirm the data transfer. 

 

3.  On the RebiSmart device… 

At the prompt “Data transfer completed”, select “OK” to close the 
connection. 

 

 

5.7.3 Reviewing treatment adherence data 

The effectiveness treatment for any condition is determined to a large extent by patient 
adherence to treatment. 

Treatment adherence is defined as compliance, or what percentage of the prescribed drug 
is actually taken by the patient, times persistency, how long a patient stays on therapy. 

iMed allows to review injection history which includes dose, date and time, indicator for 
partial injections… This can be reviewed either by a History log screen or a Calendar 
screen. 
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History log screen: 

  

Calendar screen: 

 
 
iMed also allows you to view treatment adherence and clinical parameters, such as 
relapses or EDSS, side-by-side.  This can be a helpful tool in working with patients to 
reinforce the importance of adhering to treatment. 

 


